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About the Author 
Hello and welcome to Excel Campus!   

My name is Jon Acampora and my goal is to help you improve your 

Excel skills and save you time with your everyday tasks. 

The blog at ExcelCampus.com is filled with articles and videos that 

contain tips, techniques, and tools to help you learn Excel.  I am 

passionate about learning Excel and want to share that knowledge 

with you.  

I would like ExcelCampus.com to be a place where we can all learn 

from each other, so I encourage you to leave comments and give 

me feedback.  No question is too simple or silly, so please don’t 

hesitate to ask. 

You can read more about me at excelcampus.com/about. 
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Introduction 
In my first accounting job out of college, I was fortunate enough to have some co-workers that were 

very efficient at using keyboard shortcuts in Excel.  In particular, one of my co-workers Inge was an 

absolute ninja with the keyboard.  She knew a ton of keyboard shortcuts and could fly around Excel like 

it was second nature.  I also felt like she could complete tasks 10x faster than me because she was so 

good with the keyboard. 

Do you know anyone like this in your office?   

Well, I saw how much time Inge was saving by using keyboard shortcuts, and I wanted to do the same.  I 

knew that improving my efficiency would free me up to take on new projects and expose me to new 

opportunities. 

So I set out to become a keyboard ninja.  It was not easy at first, and it took me time to learn to use the 

keyboard efficiently.  But the results were well worth the effort.  I progressed slowly and started to 

become faster and faster as I committed more keyboard shortcuts to memory.  Over time I have learned 

a ton of keyboard shortcuts that have made me more efficient with Excel. 

I still don’t know that I will ever be as fast as Inge, but I find that the benefits of learning shortcuts can 

be applied to other areas of your work.   I believe that is helps you think about how to accomplish tasks 

more efficiently and save time with everyday tasks.  This type of thinking will make you a valuable asset 

to your company, as I believe every company is looking for ways to save time and improve productivity.   

So I encourage you to learn as many shortcuts as possible.  Take your time with this learning.  There are 

so many shortcuts in Excel that it can get overwhelming.  But the best thing to do is start with the basics 

and practice, practice, practice.  Then practice some more.  

This book will start you with the basics of navigating around Excel with keyboard shortcuts.  This 

includes shortcuts for selecting cells and ranges, moving between worksheets and navigating through 

the ribbon menus to perform commands. 

You will learn when it is best to use the mouse or the keyboard for a task, and by the end of the book 

you should find yourself saving lots of time by using more shortcuts in Excel.  
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Keyboard vs Mouse – Who Wins? 
This topic has been debated for a long time.  In doing research I found articles dating back to the 1980s 

about which device is more efficient.  For example, this study titled, “Comparison of Mouse and 

Keyboard Efficiency” done by a group of professors and researchers at DePaul University in 2010, goes 

into great detail on the subject.  It actually measures the keyboard and mouse actions by users down to 

the hundredth of a second.   

These are some incredibly detailed tests, and beyond the scope of this book.  But the researchers 

concluded that the keyboard is more efficient when the user has practice using them.  If the user does 

not know the shortcut at all, then it is more efficient to find the command on the menu with the mouse. 

 

The point is that there is a lot of debate on the subject.  In my opinion, both are the winners. 

There are some actions where the keyboard is faster, and some actions favor the mouse.  A lot will also 

depend on which keyboard shortcuts you have committed to memory.  If you don’t know the keyboard 

shortcut for a specific task, then using the mouse will probably be faster. 

A Case for the Keyboard 
The nature of the Excel application makes the keyboard a very efficient tool because we are working on 

a grid (spreadsheet). 

This grid is very easy to navigate with the arrow keys on the keyboard.  The movements between cells 

are simple: up, down, left, and right directions, so we don’t always need the pin-point accuracy of the 

mouse cursor. 

This allows us to make very precise and fast movement with the keyboard when working in the grid.  If I 

want to select the cell three cells to the right of the current selection, I can quickly press the right arrow 

key three times.  I can probably complete this key press in the amount of time it takes me to just place 

my hand on the mouse. 

I know I’m starting to sound like Dwight, from the Office (TV show), but the point is that it is important 

to think about these actions you are taking with either the keyboard or the mouse.  You want to 

determine what the fastest alternative is.  If you are using Excel all day, every day then this can add up 

to a lot of wasted time. 

http://facweb.cs.depaul.edu/sjost/csc423/examples/anova/efficiency.pdf
http://facweb.cs.depaul.edu/sjost/csc423/examples/anova/efficiency.pdf
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The Save Example 
Here’s one simple example where using a keyboard shortcut is probably faster than the mouse.  The 

following is a list of actions required to save the file you are working on.  We will assume that you are 

typing and have both hands on the keyboard. 

Mouse Keyboard 
1. Put right hand on the mouse. 1. Ctrl+S with your left hand on the keyboard. 
2. Move mouse to the File Menu.  
3. Left click the File Menu.  
4. Move mouse over the Save button.  
5. Left click the Save button.  
 

In the example above, using the keyboard will take less time to save the file and is clearly the winner.  

The only problem is that you have to know the keyboard shortcut to save the file, Ctrl+S. 

As you learn more keyboard shortcuts, you can slowly transition away from the mouse and use the 

keyboard more.  But there will still be some actions that you will always use the mouse for.  A lot of 

times it is faster to use the mouse and keyboard at the same time.  Controlling the mouse with the right 

hand and typing keyboard shortcuts with the left hand can save you lots of time with certain tasks 

(reverse that if you’re a lefty). 

 

When to use the Keyboard or the Mouse 
How do you know when to use the keyboard or the mouse then?  Well the best way I’ve found is to take 

time to stop and think about an action you are performing with the mouse, and determine if you would 

save time by learning the keyboard short equivalent.  In the “Save File” example above, it is pretty clear 

that the keyboard shortcut would save you time. 

Ok, that should give you an understanding of why the keyboard shortcuts are important.  Now let’s 

actually learn some!  

 

The Arrow Keys 
I probably press the arrow keys more than any other key when working in Excel.  

When combined with a few other keys, the arrow keys can help you fly around the 

worksheet quickly.  

So I think it’s best to familiarize yourself with the arrow keys on the keyboard.  Any 

experience you have playing the piano, Tetris, or any other video game will come in handy here.  

I recommend getting a good keyboard that has a set of arrow keys that are big and easy to press.  Many 

laptops have small arrow keys in hard to find places, and this will really slow you down when working in 

Excel.  Checkout my article on The Best Keyboards for Excel Keyboard Shortcuts for an in-depth look at 

http://www.excelcampus.com/keyboard-shortcuts/best-keyboards-for-excel-keyboard-shortcuts/
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all the features that make for a great Excel keyboard.  This will help you with your next keyboard or 

laptop purchase. 
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Video Series 
Click the following link to get access to the video series that follows this book. 

http://www.excelcampus.com/navigate-excel-with-the-keyboard 

 

Getting Around the Worksheet 
Do you ever find yourself scrolling down thousands of rows with the scroll wheel on the mouse?   

Don’t worry, I’m guilty too.  But this can be very time consuming.  And unless you are using that time to 

take a sip of coffee, then I recommend learning the keyboard shortcuts to jump you there instantly. 

I am going to use this worksheet that contains a list of data as an example.  This sample sheet only 

contains a few rows and columns of data for presentation purposes.  But as you read through the 

examples, try to imagine how effective the shortcuts will be if you apply the techniques to a large list of 

data. 

 

 

  

http://www.excelcampus.com/navigate-excel-with-the-keyboard
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Home & End Keys 
The Home and End keys are important keys that you will use often. 

Ctrl+End is the shortcut to select the last used cell in the worksheet.  In the example, pressing Ctrl+End 

will select cell D67 and scroll the sheet down and to the right to make the cell visible. 

 

 

Ctrl+Home is the shortcut to select and view cell A1 in the sheet.  If you have freeze panes enabled on 

the sheet then this will scroll to the cell to the bottom-right of the freeze panes intersection. 

 

These two shortcuts will save you a lot of time!  Especially if you are using a track pad on a laptop for a 

mouse.  So it’s best if your laptop has the Home and End keys easily accessible.  
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Ctrl+Arrow Keys 
When you hold down the Ctrl key and then press an Arrow key, the last used cell in the current data 

region will be selected.  For example if I start in cell A1 then press Ctrl+Down Arrow the last used cell in 

column A will be selected. 

 

Ctrl+Right Arrow works the same way and will select the last used cell in the current data region of the 

row. 

The term data region refers to a range of cells that is bound by a blank cell.  In the case of Ctrl+Arrow 

Key, this means that the last cell before a blank cell will be selected.  For example, if I select cell C1 and 

press Ctrl+Down Arrow then cell C7 will be selected.  That is because C7 is the last cell in the current 

data region before a blank cell (cell C8 is blank). 

 

This trick can work to your advantage when you are jumping around a sheet, and it is best to practice 

this to learn the behavior of the Ctrl+Arrow Key shortcuts. 
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Selecting Ranges 
Besides navigating, the other two most common keyboard shortcuts you will use are copy & paste.  To 

me, one of the best features of Excel is that you can copy everything you’re working on and paste it to 

another place.  This allows you to instantly create a new scenario of your model, and also saves you a 

ton of time. 

To copy and paste effectively, you need to know how to select ranges of cells quickly.  This is where you 

start to become a ninja!  

The Shift Key helps with selecting ranges of cells.  We will use a combination of keys with the shift key to 

learn how to select different ranges. 

 

Holding down Shift and pressing the Arrow Keys will allow you to select a contiguous range of cells.  

You can continue to press the arrow keys to add more cells to your selection. 

 

Ctrl+Shift 
Ctrl+Shift+Down Arrow is the keyboard shortcut to select all cells from the current cell down to the last 

used cell in the column.  This is probably the one I use the most to select a column in a data region and 

then copy/paste it to another location. 
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Instead of left-clicking and holding on cell A2, then dragging all the way down to the end of the sheet to 

select all the cells, simply select cell A2, then press Ctrl+Shift+Down Arrow. 

The other arrow keys work the same way, but practice with Ctrl+Shift+Down Arrow to get the hang of 

it. 

Ctrl+Shift+End will select the all the cells from the current cell to the last used cell on the sheet.  I use 

this often when I want to delete everything below and to the right of a specific cell.  Just select the cell 

below the one you want to keep, then press Ctrl+Shift+End to select everything below it.  Then press the 

delete key.  Again, this a lot faster than scrolling vertically or horizontally with the mouse. 

 

Ctrl+A will select all the cells in the current data range.  This is great if you want to select an entire table 

or list of data.  Pressing Ctrl+A twice will select all the cells on the worksheet. 

 

Select Entire Row or Column 
Shift+Space Bar selects the entire row. 
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Ctrl+Space Bar selects the entire column. 

 

These are two quick shortcuts that I use all the time.  And here are a few bonuses for you. 

To select multiple rows - once you have selected an entire row with Shift+Space Bar, then hold shift 

and press the down arrow key. 

 

This also works if you have a few cells in a column selected first.  For example, select cells A2:A6 (use 

Shift+Down Arrow just for practice), now press Shift+Space Bar.  Rows 2 to 6 will be selected. 
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Add/Delete Entire Rows or Columns 
This is another bonus because it goes beyond basic navigation, but I think you will really like it. 

After using the shortcuts above to select entire rows or columns, you can simply press either of the 

following two shortcuts to add or delete rows or columns. 

Ctrl+ + (that’s the ctrl key and the plus symbol on the keyboard) will add a row/column. 

 

 

Ctrl+ - (that’s the ctrl key and the minus symbol on the keyboard) will delete the row/column. 

 

If you have multiple rows/columns selected, then that number or rows/columns will be added or 

deleted.  For example, if you have three rows selected and you press the Ctrl+ + then three rows will be 

inserted above the selection. 

Also note that when working on a laptop you will probably have to press Ctrl+Shift+ + because most 

laptops don’t have a dedicated key with the plus symbol.  It is on the same key as the = equals symbol. 
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Go to the End of the Selection 
This is one of my favorites that will surely wow your co-workers. 

Let’s say you’ve just pasted a long column of data, and you want to jump to the last row in the pasted 

column while still keeping the range selected.  In other words, you want to view the last row you just 

pasted, but don’t want to use a shortcut like Ctrl+Down Arrow or Ctrl+End because you will lose the 

selected range.  Typically you would just scroll down with the mouse to view the last cell. 

Well Ctrl+ . (period) is your new best friend!  

 

 

Ctrl+ . will select the last cell in the selected range while retaining the selection.  The shortcut actually 

toggles through and selects each of the four corners of the selected range.  So if you have more than 

one row and column selected, Ctrl+ . will select the top-right cell.  Then when you press it again it will 

select the bottom-right cell in the selection, then the bottom-left cell, and finally back to the top-left 

cell.  It moves in a clock-wise direction selecting the corners of the range while retaining the selection. 

 

The scroll wheel on your mouse is going to get lonely after you learn this one.  
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Navigating Worksheets 
Toggling between different worksheets with the mouse can take a lot of time.  It doesn’t seem like 

much, but if you add it up you will realize that you might spend a lot of time moving the mouse to the 

tabs at the bottom of the screen, then moving it back up to the area you are working on.  This is 

especially true as our monitors get bigger. 

Ctrl+Page Down is the keyboard shortcut to select the next worksheet going from left-to-right in the 

workbook. 

 

 

Ctrl+Page Up will select the sheet to the left. 

These are really handy shortcuts, but also ones that you will want to practice.  The key press might be a 

bit awkward for your fingers at first.  On a standard keyboard, I use my right thumb and middle finger to 

go press Ctrl+Page Up or Ctrl+Page Down.  If this is too much of a stretch for you, then you can press the 

Ctrl key with your left hand and page up/down with your right hand.  Find the one that works best and 

practice it.  I guarantee it will save you time. 

When I’m doing a lot of work between two sheets, then I will move the sheets next to each other and 

use these shortcuts to switch between the two quickly. 

Ctrl+Home > Ctrl+Page+Up 
Before I send a workbook out, I like to make sure each sheet in the workbook as the top-left cell 

selected.  This is best for presentation purposes, as it starts the reader at the top of the page.  You don’t 

want to open a book and start reading the conclusion first. 

To do this quickly, I repeat the following steps: 

1. Select the last sheet in the workbook. 

2. Press Ctrl+Home to select the top-left cell in the sheet. 

3. Press Ctrl+Page Up to select the next sheet to the left. 

4. Repeat steps 2-3 until you reach the first sheet in the workbook. 
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I actually have a macro that does this, but the keyboard shortcuts are quick and also allow you to scan 

all the sheets to double check your work before distribution.  For me this is a good sanity check on the 

workbook before I send it out to others. 

 

Add a New Worksheet 
Shift+F11 will add a new worksheet before the current worksheet.  This is a simple one, but can save 

you a lot of time.  It’s much faster than right click method or clicking on the new sheet button at the end 

of the workbook.  Plus it has the added benefit of adding the sheet in a specific location, before the 

active sheet. 

 

 

Select Multiple Sheets 
Ctrl+Shift+Page Up/Down will keep the active sheet selected and select multiple sheets.  This is handy if 

you want to move a group of sheets to a new location or workbook.   
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It can also be combined with the Shift+F11 shortcut to add multiple worksheets to the workbook.  For 

example, if you want to add three blank sheets to the workbook:  

1. Hold down Ctrl+Shift. 

2. Press Page Down three times to select three sheets. 

3. Press Shift+F11 to add three blank sheets. 

The Page Up and Page Down keys are used a lot when navigating through your worksheets.  

Unfortunately, a lot of laptops have these keys in very awkward positions.  Sometimes you are required 

to press a function in combination with the Page Up or Page Down, which makes it even more difficult 

to use. 

When purchasing a laptop, I highly recommend looking at the layout of the keyboard and testing it 

before you buy.  I only say this because I have made the $1,000 mistake of not doing so.  Again, you can 

read my article on The Best Keyboards for Excel Keyboard Shortcuts to learn more. 

 

Navigating the Excel Ribbon 
If you ever used version 2003 of Excel, then you probably have an opinion about the new Office Ribbon.  

Some love it, others hate it, and all I can say is that I’ve grown to like it.  

I’m not going to try and convince you to like it, but I will tell you that you can use it to your advantage 

with keyboard shortcuts. 

The ribbon was introduced in Office 2007 and still exists today in Office 2013.  Many of the buttons on 

the ribbon have a dedicated keyboard shortcut assigned to them, and I will explain that is this section.  

But first I want to explain how to navigate the ribbon with the keyboard. 

With any cell selected, press and release the Alt Key.  You should see a bunch of small boxes with letter 

and numbers appear over the ribbon. 

 

http://www.excelcampus.com/keyboard-shortcuts/best-keyboards-for-excel-keyboard-shortcuts/
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These are the keyboard shortcuts to access each menu of the ribbon.  For example, pressing Alt then H 

will select the Home tab on the ribbon.  After you press H, you will see small boxes with letters/numbers 

appear next to each button on the Home tab.  Pressing one of these letters will perform the action for 

that button.  For example, Alt+H+W is the keyboard shortcut to wrap text in a cell. 

 

A few that I use often are Alt+H+F+S for font size, Alt+H+H for fill menu, and Alt+A+C to clear filters. 

Checkout my articles on 5 Excel Keyboard Shortcuts for Font or Fill Colors and 7 Keyboard Shortcuts for 

the Filter Drop Down Menus for more info on these ones. 

You can also use the Arrow Keys to navigate around the ribbon after you press and release the Alt key.  

Pressing the Down Arrow key will drop you down into the select tab of the ribbon.  Then press the left 

or right arrows to select a button, and enter to perform the command. 

I don’t use these shortcuts all the time, but they are good to know when you are working on a laptop 

without a mouse, or working on a Surface or iPad with a keyboard. 

 

Dedicated Keyboard Shortcuts 
This book is only going to cover navigation shortcuts, but I do want to mention a way to learn other 

dedicated keyboard shortcuts in Excel.  This is an added benefit of the ribbon that I really like. 

When you hover your mouse over a button on the ribbon, a screen tip will pop-up with a description of 

the command.  If there is a dedicated keyboard shortcut for this command, then it will be shown in the 

top line of the screen tip.  For example, hover your mouse over the Filter button in the Data menu of the 

Ribbon.  The screen tip will pop up and you will see that the shortcut to turn Fitlers on/off is 

Ctrl+Shift+L. 

http://www.excelcampus.com/keyboard-shortcuts/keyboard-shortcuts-font-fill-color/
http://www.excelcampus.com/keyboard-shortcuts/filter-dropdown-menu-shortcuts/
http://www.excelcampus.com/keyboard-shortcuts/filter-dropdown-menu-shortcuts/
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This is a great way to learn additional keyboard shortcuts.  If you are constant pressing a button over 

and over again in the ribbon, check and see if there is a dedicated keyboard shortcut for it. 

Quick Access Toolbar (QAT) 
Just like the Ribbon, the QAT can also be navigated with the keyboard by pressing and releasing the Alt 

key.  You will see numbers appear above each button in the QAT, and these represent the keyboard 

shortcuts.  So Alt+1 is the keyboard shortcut for the first button in the QAT. 

 

These shortcuts are great, and I used to use Alt+1 as my keyboard shortcut to paste values.  That was up 

until I created Paste Buddy. 

Checkout my articles on Setup the Excel Quick Access Toolbar (QAT) and  

Excel Quick Access Toolbar – Keyboard Shortcuts to learn more about how to use it.  It’s definitely a 

feature that can save you time with repetitive tasks. 

http://www.excelcampus.com/keyboard-shortcuts/setup-the-excel-quick-access-toolbar-qat/
http://www.excelcampus.com/keyboard-shortcuts/excel-quick-access-toolbar-qat-keyboard-shortcuts/
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Conclusion 
I hope this book will get you started on your quest to become a keyboard ninja.  Learning the keyboard 

has not only saved me time, but also really benefited my career.  I am able to complete tasks faster and 

find more efficient ways to solve problems. 

Learning keyboard shortcuts is not easy at first, and I encourage you to practice as much as you can.  

You can even challenge yourself by disabling the mouse for 10 minutes, and see how well you can do.  

And of course, you’ll want to play Tetris on your lunch break.  

The only other thing I can recommend is to get a quiet keyboard and get your neighbors a nice pair of 

earphones to drown out all your keyboard noise.  I swear I feel like I’m playing the drums sometimes 

when I working in Excel, and I’m sure I can be heard throughout the office.  But all those drum beats will 

hopefully get me to the finish line faster.  

What do you think? 

I would really like to get your feedback on this eBook and hear your thoughts.  What are some tips or 

techniques that you use every day to save time with navigating Excel?  Please send me an email at 

jon@excelcampus.com with any questions or suggestions. 

Thanks again for your support! 

 

 

mailto:jon@excelcampus.com

